OPTICAL SYSTEMS | LASERS & MATERIAL PROCESSING | INDUSTRIAL METROLOGY | TRAFFIC SOLUTIONS | DEFENSE & CIVIL SYSTEMS

/,\

JENOPTIK

ProgRes_Cam

Image) plugin for the control of Jenoptik ProgRes® Cameras and the acquisition of

single images and live image streams

Manual



ProgRes® CAM ImageJ Plugin



User advice

Dear user,

Please read the following information about the operation of the ProgRes® ImageJ driver
carefully before you start the operation. By complying with the advice contained in this manual,

optimum use of the functions can be made.

Editorial deadline: January 15, 2010

Documentation number: 025006-002-98-03-1001-en

JENOPTIK | Optical Systems

Business Unit Digital Imaging
Jenoptik Laser, Optik, Systeme GmbH
Goeschwitzer Str. 25

D-07745 Jena

Germany

Phone: 0049-(0)3641-65-2143

Fax: 0049-(0)3641-65-2144

E-mail: progres@jenoptik.com
Internet: www.progres-camera.com

Revision status

Date Revision Release

Information

January 30, 2010 002 001

ce

No part of this manual may be reproduced in any form (print, photocopy, micro film or any other
procedure) without a prior written permission of JENOPTIK Laser, Optik, Systeme GmbH, nor may
contents be used, reproduced, processed or distributed using electronic systems. This manual

was produced with the appropriate care. No liability will be accepted for damages resulting from
the non-compliance with the advice contained herein.

We reserve the right to modify the document following technical advancements.

ProgRes® CAM Image) Plugin


http://www.progres-camera.com/

User advice

Signs and abbreviations used in this manual

Signs and symbols

. Enumeration

< Advice / Important / Important advice
- Reference (to a text passage or image)
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Installation

1 Description

ProgRes_Cam is an Image) plugin for the control of all available ProgRes® camera types and the
acquisition of single images and live image streams. Single images and live image streams are
displayed in true ImageJ Image Windows, thus enabling the user to apply at least some of the
methods of the Imagel tool bar. ProgRes_Cam is entirely written in Java.

2 Installation

It is required that the camera driver is already installed (Driver/SDK Version 3.3.2.0) when starting
to work with ProgRes_Cam. Please copy all files shown in the table below into the corresponding
folders of the ImageJ pathway. Please make sure that there are no additional copies or older
versions of the Dlls mentioned below anywhere in the Windows pathway!

File Imagel Target Folder

ProgRes_Cam.class ImageJ\pIugins\JenOptik(*)

ProgResPaintThread.class

ImageJ\pIugins\JenOptik(*)

ProgResStdPanel.class

ImageJ\pIugins\JenOptik(*)

ProgResConstants.class

ImageJ\pIugins\JenOptik(*)

1J_ProgResControl.dll Image)
ProgRes.png Image)
FireCamJ.dll Image)
MexJCam.dll Image)
ProcessLib.dll Image)
canconj.dll Image)

) Folder JenOptik has to be created if not already present
Under Windows, you may carry out the installation also by double-clicking Install_LI_Plugin.vbs.
The Jenoptik target folder is automatically created by that script. If you use your own path for

plugins, the script should not be used.

It may be necessary to define the memory that will be used by ImageJ. When working with
Windows, commands like the following are found in the file ImagelJ.cfg:

jre\bin\javaw.exe
-Xmx400m -cp ij.jar ij.Image)
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Installation

400m means that a memory capacity of 400 MB is reserved for Imagel. This capacity may be too
small when dealing with a large number of 3x16 Bit RGB images in high resolution. In these
cases, the memory should be increased, i.e. to 800m. In any case the set value must not be
higher than the physical memory of your machine. After the relaunch of ImageJ, the new
memory allocation becomes effective.

Please make sure that your ImageJ version is 1.39p or higher!
Close all instances of ImageJ and restart ImageJ. Depending on the Image) version you will find

the plugin in the menu Plugins -> JenOptik -> ProgRes Cam or Plugins -> Miscellaneous ->
ProgRes Cam.
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Working with the plugin

3 Working with the plugin

When running the plugin, a camera control dialogue appears, and shows the “Main”- panel.
There are two panels, “Main”and “Advanced”, which can be accessed by clicking the
corresponding buttons at the top of the panel. The “Main”-panel is always displayed after the
start of the plugin.

3.1 Connect
Initially, the button [Connect] is enabled. The plugin is =101x]
connecting to the first camera found on the firewire bus, L Advanced |
and is starting the live stream acquisition in a separate get| 1| 2| 3| 4|5 |6 [ses
Image) Image Window. Exp.tine range (msee) [1-1000  w|
A *
As initial camera settings, the settings of the previous ';a:::x;'su rm%
session when the camera was closed or the default settings 1 [
are used. When the plugin is closed, the session data are TR [
stored automatically in the user path under Windows in the Btert Video || conmect || Stop ideo |
: . Time (nsec): 104 7.91fp=s
registry: L enc P

HKCU\Software\JavaSoft\Prefs\I/J_/Prog/Res/Plug/In\a_number ) ]
Dialogue appearing after the colour camera

ProgRes C7 was connected, Main panel

3.2 Controls

The control elements in the dialogue can be classified generally into 2 groups: Non Live
Controls and Live Controls.

Non Live Controls can only be used when the image acquisition was explicitly stopped before
(button [Stop Video]). Only the controls for changing the live resolutions and the trigger
functions belong to this group. All other controls are Live Controls, and can be used without
stopping the image acquisition. Nevertheless, the image acquisition may be stopped
automatically in some cases, for instance when capturing a single image (button [Capture]).

3.3 Image acquisition

Live image streams are only available in 8 bit grey or 3 x 8 bit RGB. Single images can be
captured additionally in 16 bit data words, grey and also in 3 x 16 bit RGB in normal 16 bit data
mode or in square root mode (see also your camera documentation). 3 x 16 bit RGB are
displayed in Imagel) as Composite RGB Hyperstack where every colour channel is separately
accessible.
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Please keep in mind that the current camera types do not completely fill 16 bit data words.
Depending on the type, only 14 bit, 12 bit or 10 bit are significant.

= Note: 16 bit data word images must not be saved in BMP-format, use TIFF-format.
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4 Brief description of the controls

4.1 Button bar on top (always visible)

The button bar “Set” contains the buttons [1]...[6] for saving and loading camera settings in
preset user profiles. Up to 6 user profiles can be saved and loaded.

def|1|2|3|4|5|E|Set1

Saving a user profile
Right-click onto a button [1]...[6] to save the current settings as a user profile in the user path.

Loading a user profile
Left-click onto a button [1]...[6] to load the respective user profile.

Reset camera to default settings
Click the button [def]. The default settings cannot be changed by the user.

The following parameters are parts of the user profile; the default values available by clicking the
[def]-button are indicated in brackets:

Exposure time (100 ms)

Auto exposure state (off)

Gamma (0.5 if applicable)

Gain (1 if applicable)

Cooling (off if applicable)

Live Resol. (First or second value in selection box, depending on camera model)
Capture Resolution (index 0 or 3, depending on camera model)

Capture Bit Depth index (8 Bit)

Color Interpolation index  (fast++)

Color Correction index (no)

White Balance (1.0, 1.0, 1.0 if applicable)

Triggers modes are shut off.

ProgRes® CAM Image) Plugin 10



Brief description of the controls

4.2 Controls in the “I\/Iain"-panel % ] o4
ey e | ovmoss |

" . " . . . det | 1 | 2 | 3| 4| 5|6 [sata

Input box “Exp. time range” and time slider (Main panel) oo tmerme (o) s ]
The range of the time slider can be inserted into the input box. o] N
Using the time slider, the exposure can be selected. The total I fuosxp. T~ Pick _Reset v |
: ; amms - 0: 01—

exposure time range is 1 msec to 10 sec. e : :
aln - 3. I | |

Capture |

Checkbox “Autoexp.” (Main panel) Start Video | Conrect | | Stop Videa |
Time (mzec) 104 79 fps

When the checkbox is marked, the optimum exposure time is set

) . . ProgRes C7
by the camera. As a reference, the entire image with an average

brightness of 60 % is used.

Checkbox “WB Pick” and button [Reset WB] (Main Panel)

These controls enable the setting of the white balance, and are only active for colour cameras.
After activating [WB Pick], click onto a white area in the live image. The camera now tries to find
the correct white balance to achieve a natural look of the colours. By clicking [Reset WB], the
white balance values are reset to those of the previous white balance.

“Gamma"-slider (Main Panel)
The Gamma value can be set in a wide range from 0.2 to 5.0.

“Gain”-slider (Main Panel)
The Gain value may be set in a wide range from 1.0 to 8.0.

Button [Capture] (Main Panel)

When clicking this button, a single image is displayed in a separated window, which has the
selected properties. The acquisition of live image streams is stopped and can be restarted by
clicking the button [Start Video].

A captured image can be saved by the “Save as”-command in Image) menu “File”. Please keep in
mind that 16 bit images (B/W and colour) must not be saved in BMP format. Use the TIFF format
for these images.

Buttons [Start Video], [Stop Video] (Main Panel)

By clicking these buttons, the acquisition of live image streams is started or stopped. When the
live image display window is closed, the acquisition of live images is stopped. The window can be
reopened by clicking the button [Start Video].

Button [Connect] (Main Panel)
The connection of ImageJ and the camera is set up. Refer to chapter 3.1 “Connect” for a detailed
explanation.

Textfields at the bottom (Main Panel)
The actual shutter time, the frame rate per second averaged over 20 frames and the current
camera model are shown.
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Brief description of the controls

4.3 Controls in the “Advanced”-panel

Check box Cool (Advanced panel) SNI=TES
If the camera is equipped with cooling, the cooling
function can be switched on or off by activating or el | L Advereed |
deactivating this checkbox. det| 1 ]2]sfa]s]|e s
[ (Gasl Trigger Im
Drop down list Trigger (Advanced panel) Live Resol. [14x480 Hs =l
Only the Trigger-IN modes falling and rising edge of Capture Resal. [2-B14xab0Hs v
the trigger signal can be selected. The pin “Trigger Capture, B Depth |5 Eit Data =l
Out” is fixed to the status “high”. Colar Irterpol. fferst, o . =l
Color Correction Inn =l
When the camera receives a trigger signal, a single e Jro =
image is captured and displayed in a separate (" Cap. View as Hypers. (v Cap. View as stack

window. Its resolution corresponds to the actual
settings for the live image. The trigger mode is
switched off by selecting “No trigger”.

Advanced Panel

Selections “Live Resol.” and “Capture Resol.” (Advanced panel)

In these drop-down lists, the resolutions for the live image and the captured image can be
selected. To the selection of “Capture Resol.”, an index is added as a prefix. The index should be
used when assigning the desired resolution by macros (see below).

For live images, only 8 bit grey or 3x8 bit RGB are possible.

Selection “Capture, Bit Depth” (Advanced panel)

For captured single images, different bit modes can be selected. Please keep in mind that only 10
bit, 12 bit or 14 bit of a 16 bit data word are significant depending on the camera type. The pixel
data are arranged in a way that the highest bits of a 16 Bit data word are significant. In case of a
16 Bit color data word, Image) will show a black image when it is very strongly over-exposed
although a completely white image would be expected.

Selections “Color Interpol.” and “Color Correction” (Advanced panel)
Different modes can be selected here for processing colour images (refer also to the
documentation of your camera).

Selection “Rotate” (Advanced panel)

The display of live and captured images can be rotated by 90°, 180° or 270° with respect to the
normal orientation.
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Radio Buttons Cap.View as Hypers. and Cap. View as stack (Advanced panel)

< Note: These options are only available if 16 bit color depth is set. Please select the color
depth in the respective drop-down list “Capture-Bit depth” in the “Advanced”-panel.

Cap.View as Hypers.:

This option displays the captured image as a composite 3 sliced hyper stack, each slice consisting
of a 16 bit colour channel. 3x16 bit colour images loaded from a TIFF file are normally displayed
by ImageJ in this way.

Cap. View as stack:

This option displays the captured image as a 2 sliced stack. The first slice named “High” contains
the 8 most significant bits, the second slice (“Low”) displays the residual bits for every pixel. The
bit depth of the “High”-slice is identical with the image in the Live View window.

<& Please keep in mind that images captured in any of the 2 modes can only be saved in
TIFF-format.
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Running the plugin by macro commands

5 Running the plugin by macro commands

For using macros, it is necessary that a camera is already connected to the plugin. Moreover,
the dialogue window has to remain open, since closing the window would disconnect the

camera. All macro actions are inserted in the record-window, and are recorded and confirmed by
the system in a dialogue window.

Macro commands are performed according to the following syntax:

u ou

Run (“ProgRes Cam”, “some_command”);

< Please observe that there is a blank space between “ProgRes” and “Cam” and the
guotations marks!

Command

Sample

Remark

AutoShutter=0N,
AutoShutter=OFF,

run (“ProgRes Cam”,
“AutoShutter=ON");

Enables or disables Auto shutter.

Capture

run (“ProgRes Cam”,
“Capture”);

Captures a single image; camera is not
anymore in the live mode after this
command!

CaptureResolution=so
me_integer_value

run (“ProgRes Cam”,
“CaptureResolution=2");

Sets the CaptureResolution; resolution is
corresponding to the indicated index
(index is shown as prefix in selection
box)

Gain=some_float_valu
e

run (“ProgRes Cam”,
"Gain=1.1");

Sets the Camera to Gain 1.1

Preset==some_integer
_value

run (“ProgRes Cam”,
“Preset=1");

Sets the Camera to settings saved under
the indicated preset button

Shutter=some_integer
_value

run (“ProgRes Cam”,
“Shutter=750");

Sets manual shutter to desired time in
ms

StartCamera

run (“ProgRes Cam”,
“StartCamera”);

Starts live image acquisition

StopCamera

run (“ProgRes Cam”,
“StopCamera”);

Stops live image acquisition

ProgRes® CAM Image) Plugin
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Running the plugin by macro commands

o Important Note: The actions triggered with the macro commands like “Set” and
“Capture” need some time to be completed. Therefore, please wait some time before
inserting the next macro commands, since any subsequent macro commands sent
before the action is completed will be rejected. Enter a wait statement into your
macro script if you want to execute macro commands after Preset or Capture
statements.

The following macro sample is demonstrating this procedure:

macro "ProgRes CaptureResolution-Capture-Restart"
{
/I Sequence of macro commands
run ("ProgRes Cam","CaptureResolution=1");  // Sets capture resolution
run ("ProgRes Cam","Capture"); // Captures a single image
/"
// The camera stops acquisition after performing the Capture command.

>~

/ If restart of acquisition is desired, waiting for 5000 ms is required.

>~

/ The wait statement is absolutely necessary for successful restart.

>~

/ Depending on speed of PC hardware, the necessary wait time may be shorter or even longer.

S

The necessary minimum wait time must be estimated by trial and error.
// If the wait time is too short, subsequent macros commands are rejected.
//

wait(5000); // waiting for 5000 ms
run ("ProgRes Cam","StartCamera"); // Starts live image acquisition again
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Trouble shooting

6 Trouble shooting

<& Please make sure that only one process is accessing the driver DLLs listed in section
“Installation”. The camera must not be accessed by other applications or by more than
one instance of Imagel.

Symptom Solution

Black image, no live image
acquisition

This symptom may occur when the camera is set into the
automatic exposure mode, and the light path was briefly closed.

Solution: Switch off automatic exposure and set the time slider to
a reasonable value.

Black Image when
connecting but live image
acquisition according to fps
display

The registry entry for the camera may be damaged.
Solution:

Close the plugin.

Delete the registry entry for the camera (regedit):

HKCU\Software\avaSoft\Prefs\lI/J_/Prog/Res/Plug/In\a_number

If there are more of these entries, first look into the folder
a_number where you will find the camera name.

Run the plugin and connect the camera.
Camera starts with default settings.

Plugin does not connect to
the camera although it is
physically connected.

There may be more than one reason.

Solution for almost all:

Close all instances of ImageJ and any other applications using
Java.

Close all other applications which may run the camera.

Look into the Task Manager whether the process javaw.exe (Java
Virtual Machine) is still persisting. Cancel it.

Remove the cable from the camera for a moment.

Start only one instance of ImageJ and run the plugin.

The camera should connect now.

Exception notice in Image)
when trying to call the

plugin

Most likely there are old or current versions of the driver DlIs in
the Windows pathway (normally C:\Windows\system32). If so,
remove or rename them. For more information, refer to the
section “Installation”.

ProgRes® CAM Image) Plugin

16



Trouble shooting

Symptom

Solution

Camera stops live image
acquisition

This may happen for certain high speed resolutions (designated
with HS) at exposure times close to the minimum.

Solution:
Increase the exposure time manually and click the buttons [Stop
Video] and then [Start Video].
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